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1 Introduction

1.1 Purpose of document

This document constitutes one part of Deliverable D5.3.1 on Tool adaptations for EAST-ADL. It
describes the adaptation of an Eclipse framework, Artop/Sphinx to enable EAST-ADL modeling.

The purpose to have the chosen tools, in MAENAD is to make the EAST-ADL more useable to
OEM's and subcontractors in business projects. The purpose is also to do the tools interoperable
with the EAST-ADL model using an exchange format, so that analysis performed in the context of
the Modeling Analysis Workbench (see WT5.2) will also be possible with the existing tools being
adapted in the context of WT5.3

1.2 Introduction to contents of the document

This intermediate release consists of the preliminary development of a demonstrator based on
Eclipse/Sphinx framework to be able to model and serialize EAST-ADL model with a common
exchange format, therefore enabling tool interoperability.

The document provide a step by step installation process and highlight the first usage of the
demonstrator to be able to create/modify an EA model that will be serialized in an EA-XML format.

1.3 Abbreviations
EA EAST-ADL
TP Target Platform
1.4 Software Requirement

Name Version Note
Java 1.6
TortoiseSVN 1.6.16
Eclipse 3.6
Subversive (Eclipse plug-in) | 0.7
EMF 2.6.1
EMF Compare 1.1.0
EMF Query 1.4.0
EMF Transaction 1.4.0
EMF Validation 1.4.0
GEF 3.6.2
GMF Runtime 1.4.2
MDT-UML2 3.1.2
MDT-OCL 3.0.2

© 2011 The MAENAD Consortium 5(22)
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M2M-QVT 3.0.1

Orbit R20110523182458

EMFT-MWE 2.0.1

EMFT-MWE?2 2.0.1

EMFT-MWE2-Lang 2.0.1

M2T-Xpand 1.1.0

Sphinx 0.7.0

© 2011 The MAENAD Consortium
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2 Setup Environment

2.1 Install Java

The latest version of Java at this time is Java SDK 1.6 update 27, you can download it via link
below:

http://www.oracle.com/technetwork/java/javase/downloads/index.html

The process to install it is easy on Windows platform: you will have jdk-6u27-windows-i586.exe
after downloading and run it to install Java 1.6. If you already have Java 1.5 or 1.6 version on your
computer, this step can be skipped.

2.2 Install Eclipse

You need to install Eclipse as the actual Java IDE. Of course, this can be skipped if you already
have recent Eclipse version installed (recommend to have Eclipse 3.6 version because all others
plug-ins below are Eclipse 3.6 compatible).

You can download Eclipse 3.6 via link below:

http://www.eclipse.org/downloads/ (prefer to use Eclipse Classic version)

The same to install Java, you'll have eclipse-SDK-3.6-win32.zip after downloading and just
extract it to have Eclipse Classic 3.6.

Further information on downloading and installing Eclipse can be found in the Eclipse FAQ and in
the Eclipse Readme. A general introduction to Eclipse as a Java IDE can be found in this article.

Note: Please pay attention when you define the path to extract eclipse, it should be a short path
under windows, for ex: C:\Work\Eclipses

2.3 Install Subversive

The next step is to install a Subversion client plug-in into your Eclipse installation, since such a
plug-in does not come with Eclipse out-of-the-box. Subversion is used as the version control
system for all source code and other development related resources within the Eclipse community.

Currently two different Subversion client implementations exist for Eclipse: Subversive and
Subclipse. It is hard to recommend one of the implementations since both have been around for a
while. The authors impression is that Subversive is more feature rich but not as stable as
Subclipse. As Manaed project support Subversive only, we’ll explore the way to install it below.

Run Eclipse (for ex., my case is C:\Work\Eclipse\eclipse.exe), the first time Eclipse run will ask
to define workspace’s location, please find a short relative path, such as
D:\Work\Workspaces\testl

© 2011 The MAENAD Consortium 7(22)
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& Workspace Launcher

Select a workspace

Eclipse SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspaces ['ﬁ:\Wafk‘;Wbrspaces‘ltest v erowse...

Use this as the default and do not ask again

I OK I ’ Cancel

HELIOS

Figure1: Define Eclipse workspace’s location

When Eclipse open. Run Help = Install New Software .... Add the update site below and install
feature group named “Subversive SVN Team Provider Plugin (Incubation)”

http://download.eclipse.org/technology/subversive/0.7/update-site/

& Install |Z|@
Available Software

Check the items that you wish ko install. —
ey -

1
work with: |http:.I'.I'download.eclipse.0rg,l'technology,l’subversive,l'ﬂ.?,l'update—site,l' v||[ add... ]

Find more software by working with the 'Available Software Sites' preferences,

Tarne Version

1000 Subwersive Integration Plug-in's {Incubation)

[]000 Subversive Sources {Incubation)

= [W] 000 Subversive SwM Team Provider Plugin (Incubation)
@ Subversive Revision Graph {Optional) {Incubation) 0.7.9.120110124-1700
d><p Subwersive SWh 10T Ignore Extensions {Optional) {Incul 0.7.9.120101203-1700
d><p Subversive S¥M Team Pravider (Incubation) 0.7.9.120110124-1700
d><p Subwersive SWh Team Provider Localization {Optional) {1 0.7.9.120101203-1700

Details
Show only the latest versions of available software [ Hide items that are already installed
Group items by category ‘What is already installed?

Contact all update sites during install ko find required software

Press ""Next"

Y
@

Figure 2: Install Eclipse Subversive (1)
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& Install

Install Details

Review the items to be installed,

Mame Wersion Id

= % Subversive Revision Graph (Optional) (Incubation) 0,79 I12011012,.. org.eclipse.team.svn.revision.graph. ..
@ Graphical Editing Framework GEF 3.6.2.v2011012... org.edipse,gef feature.group
% Subversive SYM DT Ignore Extensions (Optional) (Inc 0.7.9.12010120... org.eclipse.teanm.svn.resource.ignor. ..
@ Subversive SWH Team Provider (Incubation) 0.7.9.I12011012... org.eclipse.team.svn.feature.group

% Subversive S¥H Team Provider Localization (Optional) 0.7,9.12010120... org.eclipse.team.svn.nll.Feature, group

( _

Size: Unknown
Details

@ ’ < Back [ Mext = ]

Figure 3: Install Eclipse Subversive (2)
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& Install = |f'5_<|
Review Licenses
Licenses must be reviewed and accepted before the software can be installed. -
=y
Licenses: License text:

Eclipse Foundation Software User Agreement

I@I accept the terms of the license agreement:

()1 do ot accept the terms of the license agresment

@j I Finish H Cancel

Figure 4: Install Eclipse Subversive (3)

After Subversive is installed successfully, please choose Restart Now to restart Eclipse. Then
execute the following actions:

Open Window > Open Perspective - Other ..., select SVN Repository Exploring, and Eclipse
will ask to install SVN Connector. You can select “SVN Kit 1.3.5” or “Native JavaHL 1.6.12”

© 2011 The MAENAD Consortium 10 (22)
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& Install Connectors |;|E]

Subversive Connector Discovery st

Select connectors toinstall, Press Finish ko proceed with installation,
Press the information button to see a detailed overview and a link to more information,

Find: | |

f Subwversive SVMN Connectors

External S¥M connectaors For the Eclipse Subwersive project, Installation one of the

e fFollowing connectors is required to operate with Subversive, Select connector depending
on your SYM environment and operation swskem,
m M SYNKit 1.2.3 by Polarion, TMate Open Source License (1)

SN connectar based on SYM Kt library (SYMS1.5.6 SYNKiG1, 2,3 r5745), Compatible
with SWM 1.5.%, Pure Java. Supported platforms: All.

SVYMN Kit 1.3.5 by Polarion, TMate Open Source License (1)

WM connector based on SYM KiE library (SYRS1.6,15 SYNEEL 3.5 r7406),
Compatible with Wi 1.6.x. Pure Java. Supported platforms: all.

O M MNative JavaHL 1.5.4 by Polarion, Apache Software License 1.1 (T)

WM connector based on Subversion binaries {Mative JavaHL SYNj1,5.4 r33341),
Compatible with Wk 1.5.x. Supported platforms: Win32 anly.

O w MNative JavaHL 1.6.12 by Polarion, Apache Software License 1.1 (T)

WM connectar based on Subversion binaries (Mative JavaHL SWhJ1.6,12 r955767),
Compatible with SYM 1.6.x. Supported platforms: Win32 anly.

@:J I Finish ] [ Cancel

Figure 5: Install Subversive Connector (1)
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w

Install
Check the items that you wish to install, —
sy
Mame Wersion Id
@Subversive SN Conmectars 2.2.2.12011012,., org.polarion eclipse team. svn.conne
2.2.2.12011012... org.polarion.eclipse.team.svn.conne

%SUNKit 1.3.5 Implementation {Optional)

s

Select Al l [ Deselect Al

Details

Cancel

Figure 6: Install Subversive Connector (2)

W

Install Details
Review the items to be installed, —
=y
Mame Wersion Id
2,2.2.12011012.., org.polarion.eclipse,team,svn.conne

@ Subversive SYW Connectors
org, polarion.eclipse, team.svn, conne

@ SWNEE 1.3.5 Implementation {Optional) z.2.2Iz00110z...

3]

Size: Unknown
Details

[ < Back I”_ Mext =

Figure 7: Install Subversive Connector (3)
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& Install
Review Licenses

Licenses must be reviewed and accepted before the software can be installed, :').__
Licenses: License texk:

Eclipse Foundation Software User Agreement

I (331 accept the terms of the license agreement: I

("1 do not accept the terms of the license agreement

@:‘ I Finish ] [ Cancel

Figure 8: Install Subversive Connector (4)

Once Subversive Connector is installed successfully, Eclipse need to be restarted again.

231 Setup Target Platform

The development of our EAXML Demonstrator is built basically on Sphinx. Sphinx requires a
specific target platform which is a set of libraries (Eclipse plug-ins) and our plug-ins are compiled
against it. It is highly recommended to set an explicit target platform because otherwise the plug-
ins are compiled against the development environment itself in a self-hosted way which can have
unwanted side-effects.

We provide a formally defined target platform. The target platform itself in the current version is
available on the Maenad repository located at

https://www-maenad.cea.fr/svn/\WWP5/eaxml-demonstrator/com.pulsear.targetdefs

To configure the target platform in Eclipse also a target definition file is needed. The
corresponding target definition file for the above target platform can be obtained here.

Currently the target platform is based on Eclipse version 3.6, and mainly contains the following
extras: (see 1.4 Software Requirement)

e EMF (including XSD, Validation, Transaction and Compare)
o GMF

e GEF

© 2011 The MAENAD Consortium 13 (22)
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2.3.2 Add SVN Repository

Maenad projects use SVN repository. In order to check out and manage source code, the
following repository needs to be added as ‘SVN Repository’ in development environment.

o Open SVN Repository Exploring perspective;

o In SVN Repositories view, select “New > Repository Location” context item;
o The “New Repository Location” wizard dialog opens;

o Fill fields with the following elements:

o URL: https://www-maenad.cea.fr/svn/edesigner

o User: your SVN user name; Password: your SVN password;
o Select ‘Save authentification’ to avoid setting password at each action;

o Click on ‘Finish’ button to complete location creation.

233 Check Out Target Folder

Navigate the already created svn repository in 2.4.1 and go to WP5/eaxml-demonstrator/targets
and select target 3.6; right click and then export it to the local file system.

Instead of exporting the target from whithin Eclipse, you can install a svn client for windows here:
http://tortoisesvn.net/downloads.html

(Or use the embedded svn client on MAC Os via a terminal)

2.3.4 Define Windows Environment Variable

As the target definition file contains Windows environment variable EA_ TARGETS, we should
define it first.

EA TARGETS points to directory on local hard disk where target is exported from svn, for ex.:
C:\Work\targets (it does not point directly to target 3.6 directory)

Note: If you Eclipse is open, please restart it, so that it can recognize the newly set environment
variable.

2.35 Configure Target Platform in Eclipse

Open the target-3.6.target file located in the com.pulsear.targetdefs, then in the editor, click on
the “Set as Target Platform” in the top right corner of the editor.

2.4 Check Out EastAdIOnSphinx plugins

Now and after achieving all previous steps successfully, our Eclipse Workspace is ready to receive
our EAXML demonstrator plug-ins. Go to the SVN Repository Exploring perspective; navigate the
created repository in WP5/EAXML-demonstrator, select all the plug-ins and check out them.

© 2011 The MAENAD Consortium 14 (22)
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2.5

Launch EAXML Demonstrator

Create an Eclipse launch application to run the EAXML demonstrator.

The current demonstrator does not have a specific wizard related to EAST-ADL, so that a generic
project has to be first created, and then the EAST-ADL nature has to be manually added. See the

4 next figures below.

@ Safari File Edit View History Bookmarks Window Help EB oD = ¢ [ & 0:20) Mon 11:55AM Q
0006 EAST-ADL - Eclipse Platform =)
il |B ]35O~ Qur | 88+ | 2+ ] v ilvts v e e
© EAST-ADL Explorer 82 [0 Project Explorer | ER-] =q)

> ZarProject21 D

> ZarProject21_E

» BarProject21_F

» ZarProject3x_D

» ZarProject3x_E

» @ cProject_ A

» = javaProject_A

I
New » = Project...
Show In X&W > |
[2 Hummingbird10 Model
Copy ®C (&) InstanceModel20 Model
Copy Qualified Name & TypeModel20 Model
[ Paste 3%
% Delete ® 9 Example...
w Import... £ Other... %N - —
4 Export... 1 rties 53 9] Error Log | = (=]
& Refresh 5
T — Properties are not available.

o* 0 items selected

Figure 9: Create new project

© 2011 The MAENAD Consortium
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® Eclipse Qe S D ¢ B4 B 020 Monll:56AM Q
000 EAST-ADL - Eclipse Platform (=)
Jr3- 1350 Q- Que | 807 | v | ] Gl <o e Bl
© EAST-ADL Explorer & . [ Project Explorer | & v =0 =g
> =arProject21_D ”

» SarProject21_E
» BarProject21_F
> +arProject3x_D Select a wizard fa—

»SarProject3x_E Create a new project resource r
b 2 cProject_A J
» =7 javaProject_A

Wizards:
[ type filter text (%)
% Java Project
# Java Project from Existing Ant Buildfile
52 Plug-in Project
¥ (= General
» (= CVS
¥ [=Eclipse Modeling Framework
b= Java
» (=Model to Model Transformation
» (= Plug-in Development
»(=SVN re
» = Other 0
=v=0
@ < Back ( Next> ) ( Cancel ) Finish
A
i 0 items selected

000

Q
EAST-ADL - Eclipse Platform (=]
=t |@ ]35O Qur |80+ | 2+ | biviiv e Gy B
© EAST-ADL Explorer & \_[5 Project Explorer | BgY" El]f =l

» ZarProject21_D ”
» ZarProject21_E g Q n New Project
»ZarProject21_F
» ZarProject3x_D Project
> ZarProject3x_E Create a new project resource. ﬁ
» & cProject A
» = javaProject_ A

Project name: [MyFirstEAPorje:t l

¥ Use default location

Location: /Users /aliakar/Work/Workspaces/ New_ myFi ( Browse.. )

Working sets
[ Add project to working sets
Working sets: 1 ( Select..
“v=n
@ ( <Back ) ( Next> ) (_ cCancel ) (C Finish )
/)
Iffare 0 items selected

Figure 11: New project wizard
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fann

Irs- |G | #5 O~ Qur | 57 | 977 |

[ Project Explorer |

» ZarProject21_D
» ZarProject21_E
»ZarProject21_F
» ZarProject3x_D
» ZarProject3x_E
» @ cProject A

> = javaProject A

» £ MyFirstEA

New >
Go Into

%C

Y

Move...

Rename... F2
£ Import...

4 Export...

2 Refresh F5
Close Project

Run As

Debug As

Team

Compare With

Restore from Local History...
Configure

Sphinx Examples >

vvvyw

v

Properties

¥ Delete ®

(I Properties %% @] Error Log|

= © =0

& MyFirstEAPorject

" Property
Add Xtext Nature <ed “Sinfo

Convert to Plug-in Projects... derived
cditabe
last modified
linked
location
name
path

@

Value

false

true

October 17, 2011 11:57:32 AM

false

/Users/aliakar/Work/ / i N
MyFirstEAPorject

/MyFirstEAPorject

The second step is the creation of a EAST-ADL model which
figures. This time a specific wizard is available to this end.

006

Figure 12: Add EAST-ADL Nature

Irs- |G | $5 O~ Qur | 57 | 977 |

83 [1 Project Explorer |

» ZarProject21_D
» ZarProject21_E
» ZarProject21_F
» ZarProject3x_D
» ZarProject3x_E
» @ cProject A

> = javaProject A

Go Into

[ Copy #C
Paste 8V

X Delete ®

Move...

Rename...

g Import...

&4 Export...

& Refresh F5
Close Project

Run As

Debug As

Team

Compare With

Restore from Local History...
Configure

Sphinx Examples »>

vvvywy

v

Properties 8l

9 Project...

[¥ File

(5 Folder

2 Hummingbird10 Model
2 InstanceModel20 Model
& TypeModel20 Model

9 Example...
w Other... #EN

(I Properties %% @] Error Log|

= =0

& MyFirstEAPorject

Advanced Prope

¥info
derived
editable
last modified
linked
location
name
path

Value

false

true

October 17, 2011 11:57:32 AM

false

/Users/aliakar/Work/ / i N
MyFirstEAPorject

/MyFirstEAPorject

Figure 13: Create EAST-ADL Model
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aan

EAST-ADL - Eclipse Platform
=5 | B %5 O~ Qur | 80+ | 2] iiviin s v Ry
© EAST-ADL Explorer 8% ({5 Project Explorer | BgY" Eli[ =1/)
» ZarProject21_D ”
» ZarProject21_E
»ZarProject21_F m M
» ZarProject3x_D Select a wizard —
> ZarProject3x_E Create a new EastAdI10 model |
» @ cProject A o
» & javaProject A
» 22 MyFirstEAPorject | Wizards:
type filter text (%)
et -
%4Java Project
s Java Project from Existing Ant Buildfile
4 Plug-in Project
HXtend Class
¥ (= General
»E&Cvs
v (= EAST-ADL Wizards
P EastAdI10 Model
» (= Eclipse Modeling Framework
» = Example EMF Model Creation Wizards »
> = Java 4
¥ (= Java Emitter Templates v
#v=0
@ ( <Back ) (Next>) ( Cancel ) Finish F
/)
last modified October 17, 2011 11:57:32 AM
linked false
location JU: /aliakar/Work/ / i New_ y
name MyFirstEAPorject
path /MyFirstEAPorject
C V<>
[0 & MyFirstEAPorject |

“ Q
000 EAST-ADL - Eclipse Platform (=)
=t |@ ]35O Qur |80+ | 2+ | Liviives vy )
© EAST-ADL Explorer 8% ({5 Project Explorer | B& =0 =)
»ZarProject21 D ”
» ZarProject21_E
» SarProject2]_F 800, dle,
» ZarProject3x_D EastAdI10 Model N
> ZarProject3x_E Create a new EastAd|10 model ¢
» & cProject A ‘_l
» = javaProject_A
» L MyFirstEAPorject | Enter or select the parent folder:
MyFirstEAPorject
» S arProject21_D
» SarProject21_E
» ZarProject21_F
> ZarProject3x_D
» ZarProject3x_E
» = cProject_A
» = javaProject A
2 MyFirstEAPorject
“v=n
File name: L yFi |eaxml J
E
2011 11:57:32 AM
Jruntime=Ni i i
@ (_<Back ) @ Next>=) (( Cancel ) (Finish (:.'elcv‘mrkl = i
Zorject

Figure 15: Enter file name
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Due to some minor issues on the XML schema used, you have to select the root object named
Eaxml, in the last window of the creation wizard.

S aEGIDse o i —— — ol “ D@8 D =« B Gho19 MonlliSoAM Q
000 EAST-ADL - Eclipse Platform
‘,;,y v Qv Qv | £0v | v 0 b e o [0
© EAST-ADL Explorer 52 (5 Project Explorer 2%~ =0 =g
» ZarProject21_D
» BarProject21_E Ve ‘
» SarProject21_F 8 New,
» BarProject3x_D EastAd|10 Model
> ZarProject3x_E Select a model object to create ‘&
» i cProject A L
» =0 javaProject_ A |
| » Y MyFirstEAPorject | Model Object
[Eaxmi -
Autosar
Eaxml
UTF-8 ]
F = ven
12011 11:57:32 AM
e e ; ;
® ( <Bak ) ( Next> Cncel ) GEm . = %

drject
Zdorject

= MyFirstEAPorject

Figure 16: Select Root model

From now on, you could create whatever model element by right clicking on the root model, and
then further by adding child to any existing element.

On the navigation side, you will see a tree representing the hierarchy of you model including all
designed element (no filter are made up to now).

On the editor side, the generic view is also the same tree representation.

On the property tab, you could find all relevant properties for a given East-ADL object.
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I rs- |5 195+ 0~ Qur [ g0v | v | v iive v ‘
(@ EAST-ADL Explorer %2 [t Project Explorer | 5% 7 = 04 MyFirstEaModel.eaxml &, k)
»>BarProject21 D Contents Tree
» ZarProject21_E
»ZarProject21_F
» ZarProject3x_D
» = arProject3x_E
» i cProject A
» & javaProject_A

This section enables the contents of this element to be edited.

v % MyFirstEAPorject
.project
v 4 MyFirstEaModel.eaxm| 0 8Z
<4 Eaxml sy
®C
8V
¥ Delete ®
Run As >
Debug As >
Team >
Compare With >
T Replace With >
[ Properties 33 9] Error Log| s =0
4 Eaxml [Eaxml]
Property Value

==
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Figure 18: Edit EAST-ADLModel
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Figure 19: Create New Child
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3 Summary and Conclusions

The whole EAST-ADL model is implemented in this demonstrator. Since it is based on a version of
a Schema which still contains several minor issues, the corresponding modeling representation
might suffer from some inconsistencies.

The next step will be to resolve those issues and integrate several enhancements like wizard,
filters on the tree to have a more confortable editing environment.

The second point consist in the investigation to be able to integrate Papyrus modeling capabilities
through the EAST-ADL profile with automatic transformation.

© 2011 The MAENAD Consortium 22 (22)



